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Chapter 1: Getting Started

WANSyncHA 1IS is a Microsoft IIS web server switchover solution based on
asynchronous real-time replication and automated application switchover and
switchback to provide cost-effective business continuity for Microsoft IIS on both
32- and 64-bit Windows servers, as well as MSCS clusters.

WANSyncHA offers push-button or fully automatic switchover of mission-critical
web, FTP, NNTP and SMTP servers over a LAN or WAN, IIS-aware status
monitoring, integrated continuous data protection as a guard against data
corruption, and completely non-disruptive automatic testing of your IIS disaster
recovery system, all in a system that sets the standard for ease of configuration
and management.

About This Guide

This document is a guide to implementing a high availability solution for
Microsoft IIS Server 5 and 6, based on WANSyncHA replication to a remote
secondary server with automated switchover and client redirection.

Please review each procedure before starting, in order to ensure you have the
appropriate resources and permissions to carry it out.

Related Documentation

Requirements

Use this guide along with the WANSync User Guide.

This section describes the requirements for running WANSyncHA for Microsoft IIS
server.
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Requirements

Infrastructure

To implement high availability with WANSyncHA for Microsoft IIS
Server, you must have/implement the following:

Two servers running Windows Server 2000 or 2003

- Both servers should have the same level of service packs and hot fixes
installed

An instance of Microsoft IIS Server 5 or 6 installed on each server

- Both servers should have the same IIS services installed: WWW, SMTP,
etc.

- Both servers should have identical web service extensions installed
- Full paths containing site files should be identical on both servers

The passive server should hold a clean installation of IIS with the default
sites only

Sites on the master server should not use URL redirection or UNC path
redirection

If anonymous access is enabled and used, configure the following:

- In order to keep permissions synchronized between the two servers,
both IIS processes should use the same user account for anonymous
user access. Create a new domain user account and configure both IIS
servers to use it. The following articles describe how to do this:

- For IIS 5.0: How To Configure IIS 5.0 Web Site Authentication in
Windows 2000 http://support.microsoft.com/kb/310344

- For IIS 6.0: How To Configure IIS Web Site Authentication in Windows
Server 2003 http://support.microsoft.com/kb/324274

- Please note that although the article does not specify it, it is required to
edit the local (or domain) group policy to allow the user account the
following privileges: Allow log on locally, Allow log on as a batch job, and
Access this computer from the network. Also, make sure to duplicate any
permissions changes made to the file system for the original anonymous
user account to the newly assigned domain account as well.

In IIS 6.0, if you define any new Application pools on the master server you
should also define them on the replica server

If you are using SSL encryption, please see the following MS article
concerning copying the proper certificate: How to load balance a Web server
farm by using one SSL certificate in Internet Information Services version
6.0 and in Internet Information Services 5.0
http://support.microsoft.com/kb/313299

Statically assign all IP addresses (DHCP-assigned IP addresses on the
master or replica server are not supported)

The protected server is not a domain controller or DNS server
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Non-Intrusive Installation

Log On Account

The WANSyncHA service log on account must satisfy all of the following
account conditions:

It is a member of the Domain Admins group. If the Domain Admins group is
not a member of the built-in domain local group Administrators you must
use an account that is.

It is a member of the local machine Administrators Group. If the Domain
Admins group is not a member, add the account manually.

Important! If your company's security policy requires more granular
permissions than described, please contact technical support to receive
detailed instructions. Special considerations apply to IIS servers operating
workgroups: see MS IIS Servers Operating in a Workgroup.

Non-Intrusive Installation

During installation and configuration of WANSyncHA, Microsoft IS Server on the
master server continues working without any interruption.

Determine Which Redirection Method to Use

There are four ways in which you can redirect clients after switchover: Redirect
DNS, Move IP, switch computer name, and custom scripts. You can use each
method alone or you can use them in any desired combination.

Important! If you will be redirecting File Shares, in which clients connect to via
the master server name, switch computer name must be enabled. For example,
if the master server's name is fs01 and clients connect to \\fsO1\sharename or
\\fsO1.domain.com\sharename then you must use the Switch computer name
method. It's also recommended to enable one other method as well. The most
common method is to use both DNS Redirection and Switch Computer Name.

Redirect DNS. Upon failure of the master, the replica server modifies the
appropriate DNS record so that references to the master server resolve to
the replica's IP address rather than the master's IP address. This solution is
the easiest to implement and requires no network reconfiguration. DNS
redirection works only with A (host) type records and cannot update CNAME
(Alias) records directly. However, if the CNAME record points to the modified
A record, it is indirectly redirected.
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Determine Which Redirection Method to Use

Using the record that has the master server's name is the default, however
you can configure WANSyncHA to redirect any DNS A (host) record via the
Master's name in DNS setting in the switchover properties tab.

[—rf-l- Metwork Traffic Redirection

=] Move 1P Off
AR edirect OMS on
- E| Master name in DM hiost. exarnple. com
—HEl} Master IPs in DMS
— IP address 192.165.210.23
L IP address Click here to add new IP,
=tEl) Replica IPs in DNS
] 1P address 192.168.220.112
=] IP address Click here to add new IP,
— Switch computer name CFff

m Move IP. This redirection method is usable only in a LAN configuration in
which the master and replica servers reside in the same network segment.
In this configuration, switchover of the master server causes the replica to
take over one or more of the IP addresses assigned to the master server.

If you want to use Move IP, please see Move IP Redirection before
configuring the replication scenario.

m  Switch Computer Name. If you are redirecting File Shares, in which clients
connect via the master server name, enable switch computer name. For
example, if the master server name is fs01 and clients connect to
\\fsO1\sharename or \\fsO1l.domain.com\sharename, use the Switch
computer name method. It's also recommended to enable one other method
as well. The most common method is to use both DNS Redirection and
Switch Computer Name. WANSyncHA makes the required computer name
switch by assigning a temporary name to the master server and taking over
its computer name for use with the replica server: WANSyncHA updates
records directly and does not generally require a reboot. If, however, you
encounter any problems after switchover, consider setting the reboot option
to On and testing again. For most cases, the reboot option is not required.
Please see Switch Computer Name Redirection.

m  Custom Scripts. WANSyncHA can trigger custom scripts or batch files to
perform the user redirection or any additional steps not covered by built-in
methods. If the above methods are not appropriate or do not fully meet all
requirements, please see the WANSync User Guide for details on scripted
redirection methods.

MS 1IS Servers Operating in a Workgroup

For servers in a workgroup, set the XOsoft Engine service account to Local
System (unless you have added any custom scripts that require higher level
permissions). Servers in a workgroup can use Redirect DNS only with DNS
servers that allow non-secure updates. You can use Move IP, switch computer
name, and custom redirection scripts normally.
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About MSCS (Shared Storage) Clusters

About MSCS (Shared Storage) Clusters

License Keys

[ecoster xosolt wansyneManoger x|

With WANSyncHA, installing on clusters is much the same as a standard
installation. To install on a cluster, enter the IIS Server’s Virtual Server Name as
the master or replica name. You must also install the XOsoft Engine on all cluster
nodes.

For detailed instructions on using Move IP with clusters, please see Move IP
Redirection before configuring the replication scenario.

When first opening WANSync Manager, it prompts for a license key. This key
determines what scenario types and features are available. To simplify key
installation, you can paste the entire key directly into the first text box.
Subsequent text boxes are filled automatically. After opening the Manager, you

can view and apply license keys from the Help, About menu.

Registationkey: | | - - | -| -|

Please enter a registration key to activate this software

If you have not received a ragistration key vet, please contact us
at sales@xosoft.com. Be sure to provide us with your name,
compary name, amail addrass and telephone number and

we will send you the proper registration key promptly.

Thank you

/ Paste the entire key into this box

WANSyncHA Components

WANSyncHA is comprised of the following components:

m  XOsoft Engine. WANSyncHA’s service - runs on each server involved in the
scenario.

m WANSync Manager. Management GUI - used to manage and configure
WANSyncHA.
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WANSyncHA Components

XOsoft Engine

The XOsoft Engine is the executable file that lies at the heart of the WANSyncHA
system. It is installed on every host participating in replication and must be
running before any replication scenario can run. Each engine can act as a master
or replica with respect to each replication procedure or tree. It can also
participate in more than one replication tree, as long as the file system
directories, to which the different replication procedures are applied, don't
overlap one another. WANSyncHA communicates via default TCP port 25000
(you can change the default port number).

WANSync Manager

The Manager is a graphical user interface (GUI) application that controls all
replication hosts, both in the definition and operation (running) of replication
services. The offline process is mainly the definition of replication scenarios.
Once a replication scenario is sent to the participating hosts, the Manager also
provides the means for online control (running, synchronizing, etc.) and
monitoring (i.e., node status, log files, etc.). You can operate the WANSync
Manager from any location from which connections are established to
WANSyncHA hosts.

Note: The Manager connects as a TCP client to master and replicas defined in
the replication scenario. Once a replication process is running, the Manager is no
longer required for the process to continue. Connection to replica hosts is not
mandatory - it is required only in order to enable selection of destination
directories via browsing, instead of manually. Connection to the master host is
mandatory.
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Chapter 2: Server Setup

This chapter describes the most common setup for WANSyncHA for IIS servers.

Install WANSync Manager

Install WANSync Manager and the Remote Installation Wizard onto the machine
from which the WANSyncHA scenario will be configured. The location of the
Manager is not critical so long as it is accessible in the event of a disaster.
Frequently, the Manager is installed on an administrative workstation.

Note: If the Manager is installed directly on either the master or replica servers,
ensure that the XOsoft Engine is also installed.

|§J Z0soft WANSync - X0soft Installation Wizard

Custom Setup

Select the program features you want installed. X Soft

Jesr Eregr Wo

lick. om an icon in the lisk below to change how a Feature is installed,

= Feature Description
Tool For ¥Osaft MWARTwno
configuration and monitoring.,
This Feature should be installed
on Management bost only,

This Feature requires 15ME on
wour hard drive,

Install ko

CiProgram Filesh X osaft WamSync, Change. .. |
InstallShield
Help Space < Back I Mext = I Cancel |
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Prepare the Servers

If you intend to use the XOsoft Remote Installer (recommended), the machine
on which you are running the remote installer must have the .Net framework 2.0
installed. The framework is required only on the machine running the remote
installer wizard (GUI); the target servers do not have this requirement.

After the scenario is run it is cached on your master and replica servers. Once
cached, you can download it to any installed WANSync Manager by selecting
Download from the File menu (then enter the name of your master or replica
server).

Prepare the Servers

The following subsections describe how to prepare IIS servers for use with
WANSyncHA.

Remote Installation Wizard

You can use the Remote Installation Wizard to deploy the XOsoft Engine to any
number of servers, or cluster nodes, in one step. Alternatively, you can install
the XOsoft Engine manually by running setup.exe directly on each server.

Note: If you install the XOsoft Engine using the remote installation wizard, you
can skip the the manual installation step under the sections Master Server and
Replica Server.

Run the remote installation wizard either from the start menu or from the
WANSync Manager Tools menu. When using the remote installation wizard,
consider the following steps:

8 WANSyncHA IIS Server Operations Guide



Prepare the Servers

m  Installation location - ensure that this path is correct and contains a valid
WANSyncHA setup package

5 x0soft Remote Installer 4061 PR Tel
Steps Installation Location
Speciy a folder containing the X0sofl Engine nslalation package to be installed on the semobe hosts.

o Welcome
hr Inztallation Location
Hoztz Selection Imvstallation pack age fokdet
User Credentials
W92 168 200, 1 vnstalls \WAN S 4.0 61VWANSwne_4.0.67Y Biowsa..,
Preinztall Verification I e s —“—"-“—J
Installation Settings
Installation Package Detads
Ready Ta Install
Installing Comparg: 020l Inc,
Raport Product Name: MOzl WANS e
Product Version: 4061

+

AN

- o &

.

Remate Installer <Back [[H 1y _ Concel I
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Prepare the Servers

Steps

(Welcnme

'(Installatinn Location

[» Hosts Selection

User Credentials
Preinstall ¥erification
Installation Settings
Ready To Install
Installing

Report

7
LI\

& & &
|~ 1,/" /|

Remote Installer

m  Hosts selection - select the servers (or cluster) nodes to which you want

to deploy the XOsoft Engine (you can add servers manually from the Host
Name/IP Address box)

&= X0soft Remote Installer 4.0.61 1 =101

Hosts Selection

Select hostz from the list bellow or add a host name manually. The #0zoft Engine will be installed on the selected
hogts.,

Discovered Hosts: Selected Hosts:

| v

= D@ example. com EXCHOT example.com

IO ool (Do) EXCHDOR-4 example.com
DCO2 [DC) F201 . example.com
CLMTOZ [LOCAL) FEDR-A example.com
CLWTO 1507 .example.com
E%CHOT IISDR-4 example.com
EXCHDR-A CRACLEDT example.com
EXCHFED ORACLEDR-A example.com
EXCHFEDR-A SCOL0T .example.corn
F5 SCOLDR-A example.cam

FSDR-4

5o

ISDR-4
DRACLEDT
ORACLEDR4
5QLOT
SALDR-& |

Hozt Hame/|F Address: Sdd Hemowve

Infa: |

< Back Hewut » Cancel
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Prepare the Servers

m  User credentials - the user account that is used to install the XOsoft Engine
on each target server (ensure that this account is a local Administrator on
all target machines)

- 5 ¥Dsolt Remote Installer 4.0061 =] ll
Steps User Credentials
Enter credentials for & domain account that has sdmeisistor nghts on all selecled hosts.
o welcome
 Installation Location
'(Hnm Selection I Currer uger [EXAMPLE \WAdmarestraton
[F User Credentialz
1 The following ;
Preinstall Verification L
Installation Setings Uiser nama |
Ready To Install
Installing Patowed I
B Droemaen |
4
- g
Remaote Installer £ Back m‘& Cancel
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Prepare the Servers

m  Preinstall verification - click Next after all servers have reported success

= Installation settings - select This Account and enter the WANSyncHA
service account domain\username and password (see Requirements for more

details)
E-f_'- X0solt Remolte Installer 40061 =IEI_£.|
Steps Installation Seltings
St ratallation piopedties b ol sedected hosts
« Welcome
¥ Installation Location | 1 uiion Foder fs new instalsion
¥ Hostz Selection [ 5 uetem Disks - \Progeam Fla <Oz \WANSne
o Usor Credentials L
: | —Semvica Logon Indoemati
v Prum:l.a-ll wrm._mmn A
¥ Installation Settings  LocalS
Ready To Install & This "
Installing Domainilizer Name:  [exampletackririzialce
Report
P | -------- 1
¥ Eeep the service log on account fos esisting installations
 Host Rebaoot =
‘When upgeading froem  fonmer versson a host reboot is sequired. Fos hosts wese the reboot is requised pou can
a choose one of the folowing options:

% fuhoman:ally reboct the specied host:
 Manwaly reboot lates

PN

- o

Remote Installer

Note: Do not proceed without first setting the correct service account (see
Requirements for more details).
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Prepare the Servers

m  Ready to Install - confirm that all desired servers are listed and then click
the Install button

m  Installing - you can monitor the installation process from this screen

. = x0solt ﬂ:mnutu Irestalber -I-..EI tIEIE.I
Steps Installing
Flease, wail whde inslaling the X0sclt Engne on selecied hosts
+ Welcome
« Installation Location
o Hoztz Selection ._.lrli;_lgﬂun Hosts [ Status | Error Descnphion I
. B EXCHN Succes:
¥ Usor Credentials = EXCHDR-A Installing.
+ Preinstall Verification irsm Success
i 2 Bs01 Installing,
¥ Installation Settings SlrspR-4 installing.
| '(Hna:hr To Inztall %IIBDH-A Inztalling.
i SVORACLED Installing
P Installing = 5001 Success
Report =l ORACLEDR-A Installing...
= sOLDR-A Success
-
[ LNy
‘il_'\ Tootal ramber of inctalaicns: | 10 Success | 4 Emoc | O
800 '
Remote Installer ¢ Hack st | [ o ]
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Prepare the Servers

m  Report - in this last step you can view the full installation report and,
optionally, save a copy (the XOsoft Engine now is installed on all selected
servers or cluster nodes)

- = x0solt Remote Installer 4.0061 :IEIE-I
Steps Report
The disploped repoit summanzes the mstalatcn iesuls. Chek Frush to et the X050t Remote Instaler
o Welcome
+ Installation Location
¥ Hosts Selection XOsoft Remote Iustaller Version 4.0 Build 61 2
(U:ur Credentials
 Preinstall Verification Installation Report
o Installation Settings
! Start Time: 471872006 4:02 FH
¥ Ready To Install Finish tine 4182006 4:07 PM
i UTser Hame: EXAMFLE“hdministrator
¥ installing Product Name X¥osoft VANSync
l# Report Froduct Version: 4.0.81
Destination Folder tSyzten Dizk: “Program Files“X0=zof t~WANSyne
Serwice Log On Account: exanpletadeinistrator
Change Log On Policy: Keep the service log on account for existing :
Autoratic Reboot: Yes
Installation Results
Rehoot
- Host Name Status Logon Aceount , . . |Reboote
Required
LAY < ¥
- o=
Save As

Remote Installer ¢ Back I Frizh ﬁ[ Carpst ]
—— L3

Master Server

To install on the master server:
1. If you did not use the Remote Installation Wizard, install WANSyncHA on the
master server.

Note: When installing WANSyncHA, use the log on account as described in
Requirements.
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Prepare the Servers

If you installed under a different account than required, you can change it
any time using the Windows services console: find the XOsoft Engine service
and change the log on account. Then restart the service to apply the change.

jir X0soft WANSync - XOsoft Installation Wizard x|
Service Logon Information /‘3 »
Select a local account ar specify a user name and passwaord : SOft

fesT Errr Woixise

The ¥0soft Engine service can log on under the local svstem account or a5 a specific user, Select
local system account or provide a user name and password For the service log on. The user account:
must be in the Form DOMAIM Username,

" Local System Account

¥ This account

User Mame:
IEXAMPLE'I,P.dministratu:ur Browse, ., |
Password;
I*********l
Installshield

= Back | Mewxk = I Zancel

2. If you have file level antivirus software installed, exclude the WANSyncHA
installation directory from antivirus protection.

3. If the master server is a cluster, perform steps 1 and 2 on all nodes. You do
not need to switch over the MS IIS group during installation.

Replica Server

To install on the replica server:

1. If you did not use the Remote Installation Wizard, install WANSyncHA on the
replica server.

Note: When installing WANSyncHA, use the log on account as described in
Requirements.

If you installed under a different account than required, you can change it
any time using the Windows services console: find the XOsoft Engine service
and change the log on account. Then restart the service to apply the change.

2. If you have file level antivirus software installed, exclude the WANSyncHA
installation directory from antivirus protection.

3. If the replica server is a cluster, perform steps 1 and 2 on all nodes. You do
not need to switch over the MS IIS group during installation.
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Configure a Replication Scenario

Configure a Replication Scenario

The following subsections describe how to create and configure a replication
scenario.

Create a New Scenario
1.

Steps

Open WANSync Manager. From the File menu select New or click the New
Scenario button.

At the Welcome step click Next to Create New Scenario.

At the Scenario Type step select MS IIS Server and High Availability Scenario
and, optionally, Replica Integrity Test for Assured Recovery.

Note: Learn more about Assured Recovery and how it can help ensure
success through automatic testing. Please visit the Products menu at
www.caxosoft.com or review the WANSync User Guide for more information.

Select Scenario Type

" Welcome
b Scenano Type
Scenario Selup
Hosts
Magter Configuation
Replca Confguiation
Root Dieeciones
Seenatio Properties
Swatchover Propaities
Azzured Recovany
Scenario Venfication
FAun 5cenano

Scenario Wizard

Sedact from one of the bcensed scenano lypes isted below. I the desired apphcation iz not sted registes an
appecpeiate hoense key, Licenses keys can be registered by canceling the wizard then selecting "Registes” from lhe
"Help™ meru. Press the "Finssh™ button to continus conhguestion marnually.

— Salect Sarver Typs
[ Fie Server
M5 Bxchanga
Oracle

SGL Server
M5 IS Server

~ Select Froduct Type
" Disaster Recovery Scenado basic)
O igh Avalabiity Scenado

— Tasks on Fepbca
T Mone

% Inbegrity Testing for Assured Recovery

" ARCserve Baciup ARCserve Backup Sarver Hame I—

I with [nfegity Testing

cm|m=|ﬁﬁ]w

]
4

4,

During the Hosts step, name the scenario and input the server names for the
master and replica hosts.
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Configure a Replication Scenario

Note: If either server is a MSCS cluster, enter the cluster resource virtual
server network name (or IP address) as the master and/or replica name.

-!';; Mew SCenario

Steps Master and Replica hosts

(Wﬂlmm Erer the hostnanse or IP addiess for both the Master and Replica hoste. Master refers to the production server and
Beplica refers to the standby server. i the zcenaio will mvobve more than one teplica, press the "Finish'” button to
of Scenario Type conitinue configuation manisally,
o Scenatio Setup
P Hosts
Master Configuration

Rephca Conhgusation
oot Directories &5 Scenaiio name [MS IS Serves

Scenano Properties

Swatchover Properlies

Azsured Recovery
Scenano Yerfication

Run Scenario B RepicaHost 1P |iisd|-a _-J

&' Master HostnamenP  [is! _|

Scenario Wizard ¢ Back o B Cancal
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'ﬁ; Mew SCenario

Sleps

b Welcome

i Scenario Type

o Scenatio Setup

of Hosts

B Master Configuration
Reghcs Conliguation
Root Drectoties
Scenano Properties
Swatchover Properlies
Assured Recovery

Scenano Yerfication

Run Scenario

At the Master Configuration step, WANSyncHA displays the sites on the
master server. These are the sites that will be replicated and protected. At
this step you also have the option to exclude specific sites from replication
and monitoring.

Master Configuration (iis01)

Augtordizcovery results for MS IS Server on host 01 ae ksted below. By default all Sites wil be monitored and
rephcated. To remove specific databazes from moniboning and replication uncheck the cormesponding check bokx

Sites Full Path Redirect &
=%
=V Defaul Web Site [T c:finetpubjwmesraot
() _private 3 c:finetpubywweront
HE) _viti_bin [3) C:jProgram Files/Common FlesiMicrosoft 5.
HEE) _wti_end 3 c:finetpubjwwsroot
=) _wti_log 3 c:finetpubyweesroot
HE) _vti_pvt 3 c:finetpubjwesroct
HE) _vti_script 3 ¢ finetpubjwesront
Him _vti b [T c:finetpubessroct
{7 aspnet_clent 3 c:finetpubywwesroot
1) inkranet ) c:finetpubjwmemiront
=1V tcrosoft SharePoint Administration [3) C:fProgram Files/Common Fies/Microsoft 5...
L{3) aspnet_chent 3 C:fProgram Files{Common FilesiMicrosoft 5...
@[ Default FTP Ske 3 c:/inetpubjfrproot -
e[V Default SMTP Virtual Server (5 c:ftnetpubfmaiook
FHEIV Default NNTP Virtual Server (3 C:finetpubjnetpfilejroct =
e ST _>|‘J
Back [ Mew> Fish | Cancel |

P

Review the changes that will occur during automatic configuration on the
replica IIS server. The Copy inheritable properties option copies all settings
that are inherited by virtual directories from the parent site. This option is
selected by default and is the recommended option for most cases. Click
Next to start the replica configuration process.
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Configure a Replicatfion Scenario

For information on how to repeat the autoconfiguration process after the
wizard completes, see Autoconfigure MS IIS Using the ws_iis2iis Utility.

[Oremscenaio |

Steps

' Welcome

|k Scenatio Type

|k Scenaiio Setup

of Hosts

o Mastes Coniiguration

[ Peplica Configuration
Root Directoties
Scenario Properties
Swatchawes Properties
Aszsed Recovery

Scenano Venfication

Run Scenarnio

Mazter and Rephea MS 115 Serves Sites muzl be dentacal WANSyne will configure M5 1S Server on the Replca
automaticaly acconding to the Master's settings.

Replica Configuration (iisdr-a)

¥ Copy Inhentable Propeties

 Master [ Repica | actin
=14 Dl (Master) =14y lsdr-a (Replkca) ]
-5 Default NNTP Virtusl Server | 5 Default NNTF Virtual Server  Keep
{4z Dafault SMTP Yirbual Server ——— |l Default SMTP Virtual Server | Keep
Iﬂ: Default FTP St ————| @ Defauk FTP Site Keen
-8 Microsoft SharePoink Adminsstration  $————we| |ﬂ Microsoft SharePoirk Admi...  Create
L Defaul Web Ste - 8 Defaukt Web Site Update
4| | = 4] | id|

Scenario Wizard

ill;{r:aur and Replica 15 configurations are different.
&5 "Next" to configure the IIS on the Replica automatically

<Back W Finish Cancel
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Configure a Replication Scenario

7. The Root Directories step displays the data to be replicated. Click the Next

button to continue.

£3 New Scenario

Xl
i Root Directories
i.mistedtt below aie the Root Directories to be rephested. Targel directories vl be crested a: needed. These
n Welcome
" Scenatio Type ?h:i:'Fﬁ'E':ha'b' b::f"’*:“m ’mwd_' Edmdm the appication. | additional data is desived for rephication,
=L i o bo configut n I
o Scenario Selup
( Hosts
of" Mastes Conligustion Fﬂo‘gt Diectories —
of Replica Configuiation || =17
P Foot Directories -8 c:finetpubjfroroct
Scenano Properties -8 c:finstpubfmalroct
Swatchaver Properties & ciinstpublnntpfilejroct
Agsured Aecovery HE) cfimetpublevseroct
Scenano Venfication 3 c:fprogram Fesfcommon Flesfmicrasoft sharedjweb server extensions/S0/isapi
Run Scenario
| 2
= ik [ Hws | e | cwes |
A

Note: You can add additional files or folders to the replication after running
this wizard. Follow the prompt to run the scenario later then double click on

Directories under the Directories tab.

| Master Root Directorias | Filker |
=198 Microsoft 115
@ c:finetpub)ftprook
@ i finetpub)mailroot
@ c: finetpub)nnkpfilefrook
B cfinetpubfwweroct
= —cifprogram-filescommmon-fil-
E‘; Directaries

Direckaties @ Switchover | F‘ru:upertiesl
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Configure a Replication Scenario

The Scenario Properties step allows you to configure additional properties.
If you use NTFS ACL's (permissions) with domain accounts for user access
control, we recommend choosing the Replicate NTFS ACL option. Otherwise,
click Next to proceed.

Note: You can modify all the settings in this pane after the scenario is
created. However, before changing any Spool properties (which are
configured here), please review Spool Settings for configuration details.

x
Steps Scenario Propedlies
i Welcome Scenatio propesties wil be configured in this step. The recommended default values are histed below. Feted Lo the
; Uses Guade before madifyng the curent settings. To madily less comimon prophisties, press the "Firesh” buttor and
W Scenario Type conlinue configrstion manusly
W Scenario Setup
of Hosls
o Master Configuration = | [ Repica Properties [ vaiue |
( Regiica Conhguration o = lﬂ Replication
of Rioot Directosies ;-E] Replication mods Crnline [5] Bandwidth usage (Kbps)  Unlimited
P Scenaio Properties | E Comprass data Cff = % Spool
vt homes Propatis (3] replicate MIFS ACL O - [5] Max spool size {ME) Infirite
Astined Racovey =) Spool - [&] Min disk free size (M8) 1024
Seanaris Vanfication 18] Max spocl size (MB)  Infinite - [] spool drectory [INSTALLDIR ftmp]
Run Scenatio {-18] i disk free size (MB) 1024 1) Recovery
L[] spool drectary [INSTALLDIR tmg] - (2] Data revind Off
=) Reports =1l Reports
4[] Generate synckeori,.. On L [E] Gererste rephcationre.., OFf
i L [B] Generste detal... On - [&] Report format s
i [&] Generate replicatio.,. Cff L [&] repoet retention (days)  Unlimited
! -[5] Repart Format KL (+] Reports Handling
| [&] Report retention (d... LUnimied —
13 Reports Handling
--[ﬂ Store reports 0... 00
L [5] reports dire... [INSTALLDIRfre...
1 [a] Send to manager O =|
Scenario Wizard < Back Newt> Firish Sy
A4

The Switchover Properties step allows you to modify switchover parameters.
At this step you must choose a redirection method that suits your needs, or
click Finish to specify custom scripts manually as the redirection method. By
default, no redirection method is set to on. If you did not review the section
Determine Which Redirection Method to Use, please do so now and choose
the one that is appropriate for your configuration. In most cases, however,
Redirect DNS or Move IP work best.

Note: For users planning to use automatic switchover, please note that the
Is alive timeout (sec) setting controls how long to wait after a failure is
detected before triggering switchover.
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If you intend to use Move IP as the redirection method, please see Move IP
Redirection.

Grewscenaro e |
Steps Switchover Properties
:Q'Wnl:m Switchover propestes will be conhgured in this step. The recommended default values ae Bsted below. Refer to the
-(5 oy ger Gude befiore modifying the cunent seltings. To modily less common propristies, press the “Finish™ butlon and
| cenano |ype continues configuration manualy,
o Scenario Setup
J Hosts
o Mastes Configuration | | Propesty | vahoe |
( Rephica Configuration F_I& Switchover Properties
o Root Diectores =} E;; Network Traffic Redirection
o Scenario Properties r@ Move IP off
B Swichover Properties |-E| Redirect DNS off
Assued Recovery -—El Switch computer name CiFf
Scenario Verification =18 1s Alive
Fis nate - [E] 15 shive timeout (sec) 300
- [2] Heartbest timeout {sec) 30
518 Check with
=} [&] Send ping requast on
- [&] 1P for ping From Master to Replca  192,168.220,112
L [&] 1P For ping from Replicato Master  192.168.210.23
[#] connect to0E on
< Back Heat > Finish Cancel |
A

22  WANSyncHA IIS Server Operations Guide



Configure a Replication Scenario

10. The last step in Switchover Properties defines which steps are triggered
automatically by WANSyncHA or triggered manually by the Administrator.
Select the desired setting for each option and then click the Next button.

Important! It is not recommended to use automatic reverse replication
with IIS scenarios. (see Automatic Switchover and Reverse Replication).

“} Mew Scenario

x|
Steps Switchover Properties
'( Welcome The propestes below control sutomatic switchaver and automatic reverse repbcation
f Scenario Type
W Scenario Setup
of Hosls
(MMHWWW WMSMWMWMMMIMBMM IF automaticaly
o Replica Conhguration triggesad svatchover iz not desined, marually indisted switchover can be selected. In either case
.(meecm;eg WANSyne will provide notification messages when a Ladure is detected.
o Scenaio Properties _ _
P Switchover Properties " Switchover gutomatically
Azzured Recovery  Switch 5
Scenano Venhcation
Run Scenano
After swatchoves has completed the scenano vill stiop. For replication to occw in the reverss
direction the scenano must be n once agan WANSynG can sla ieverse
Automatically or scenano can be run manualy when approprste.
" Start aytomaticaly
™ Start manually
Scenario Wizard <Back m Firiih Cancel
“

11. The Assured Recovery step is presented only if you selected this option in
the Scenario Type step.
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£ Mew Scenario

Stepsz

of Welcome
of Scenaiio Type
of Scenaiio Setup

Note: If scheduled testing is desired, double-click on the value for Schedule:
the Assured Recovery hours screen opens allowing you to set a schedule for

testing.

Integrity Testing for Assured Recovery

I thnis shep vou can set & schedule for Integity Testing for Assured Recoveny, If a schedue i not set testing should
be marwsally tiggered. Assured Recovery properties may also be modified in this step. Wide the: defaddt values are
sufficient for complete testing, scnpts can be added and V55 snapshots can also be enabled

of Hosts
of Mastes Configuration Wahie
« Replica Configuation '-J.E_ —
«f Root Disectaies 1 ] Repiica Integrity Testing for Assured Recovery on
o Scensiio Propesties (8] schedue Not Set
of Swilchoves Propeities =1 1. start DB
P Assued Recovery |:1§.] Aukomatic on
Scenario Verification 5] user defined seript FF
Run Scenario =14} 2. Replica DB testing
-[&] Awtomatic on
(8] user defined script off
=152} 3. Actions on successful test (DB online)
- [&] User defined script off
-—_r 4. Stop DB
~[&] Awtomatic o
@ User defined script CFF
=1y 5. Actions on successiul test (DB offline)
|--E| Create Shadow Copy (V55) Off
[] wser defined seript Off
2]
Scenario Wizard < Back Mewl 5 Fnish | G |
P

12.

Scenario Verification checks many different parameters between the master
and replica and servers to ensure a successful switchover. If any errors are
reported you cannot continue until they are resolved. To retry verification
click the Retry button. Once the scenario is verified successfully, click Next
to continue.tion is complete: All modifications during synchronization are

replicated.
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Important! Although the software allows you to continue with warnings, it
is not recommended to do so. Resolve any warning situations before
continuing to ensure proper operation of the application.

[Srevscena ]

Stepsz

Scenano Yerification

o Welcome

of Scenario Type

o Scenatio Setup
o Hostz
of Master Configuration
o Feplica Configuration
o Foot Directories
o Scenario Properties
of Swilchover Properties
o Assured Recovery

[p Scenario Verification
Run Scenano

Scenario Wizard

I thnis shep the scenaio it vedfied o help entwe ploper operation. A enors must be resobved before conlinuing. 1t
iy akso sieongly recommended thal i wamings be resolved, IF contirumg with wamings, ensure ther polenbial impact
i fully understood. After making any recessan changss press the “Rein button to repeat the scenatio veriication.
Once venfication iz successhul, press "Mext" to continue,

Scenario created and verified successfully.

[ Bey | Moeino. |

ook [(Fotr ] _ rr | Cowa |

#

Run a Scenario from Outside the Wizard

1.

Select the Run button on the WANSync Manager tool bar or select Run from
the Tools menu.

Before initiating synchronization and replication, WANSyncHA verifies your
scenario configuration. When verification is complete, WANSync Manager
displays the message: Are you sure you want to run scenario
"scenario_name?" The top pane displays any warning and error messages
resulting from verification.

Note: Scenario Verification checks many different parameters between the
master and replica and servers to ensure a successful switchover. If any

errors or warnings are reported you should not continue until they are
resolved.
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Autoconfigure MS IIS Using the ws_iis2iis Ufility

3. Click OK to run the scenario. The Run screen is displayed:

Run x|

@q@' Wit Sunc will start replication after the
synchronization process completes.

Synchronization method

i* File Synchionization
i~ Block Synchronization

I¥ Ignore zame sizetime files

Skip Cancel

4. Leave the File Synchronization method with the Ignore Same Size/time Files
option checked.

Important! File synchronization is best suited for large numbers of
relatively small files. If you want to learn more about other synchronization
methods, please see the WANSync User Guide.

5. Click the Synchronize button. Synchronization can take a while, depending
on database size and network bandwidth between the master and replica.
You will receive the following message in the event window when the
synchronization is complete: All modifications during synchronization are
replicated.

At this point, real-time replication is operational and the high availability solution
is installed and active.

Autoconfigure MS IIS Using the ws_iis2iis Utility

The WANSyncHA autoconfiguration process for web sites and settings only runs
once during scenario creation in order to conserve bandwidth and server
resources. If at any point in the future you want to refresh the IIS configuration
on the replica, the ws_iiis2iis utility is provided for this purpose. You can run this
utility at the server or site level. You can also use the utility to update the replica
configuration for newly added sites (in this case you should also rerun
autodiscovery from the Directories tab in the WANSync Manager).

The utility is located in the WANSyncHA installation directory. You can use the
utility manually or scripted for a scheduled operation. Run ws_iis2iis without any
switches for a command line reference.
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Chapter 3: Switching Over and Switching

Back

Switchover

This chapter describes the switchover and switchback processes. After
completing synchronization, you can initiate switchover and switchback.

To initiate switchover:

1. Open WANSync Manager and select the desired scenario.

2. Click on the Perform Switchover button or select Perform Switchover from
the Tools menu.

Ei:-}xl]suft WANSync Manager 4.0.61
acenario  Edik

Events Wiew Tools

& B & @ |E 2 e

Help -

EEHLEAEE IR
i;;rFD;r; Swsitchover |PHICal View
SCenarico name i I Errors I Stakus

[» MSIIS Server ¢ 3 Running Active

3. Click OK on the Perform Switchover confirmation window.

This procedure initiates a switchover from the master server to the replica
server. Detailed information about the switchover processes is located in the
Events pane during switchover.
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Switchback

Important! After switchover completes the scenario stops. The only case in
which the scenario may continue to run after switchover is when automatic
reverse replication is turned on. For more information, see Automatic
Switchover and Reverse Replication.

Switchback

Bl isolt WANS e Manager 4001 EIE]|
] L
Shat -
ey Sart of replhcation: SR
Start of statitics gathering: 2754
= Iade-a Farted nqbr ﬂ”"‘ﬂ'l
i'T Wersion AQEE
2t % of thessteld
| iyt [ of Faee
> Gama |
Semdcharar i HogEE im ke ke chasapes per oot deectory:
[5e TGued  [#
| Cifihares | DEsytes. L] 14
Trafvalerred byles bo Repbess: .
i 1508 . | v
’ fida [ 12088 I
% Last synch statintics: Fike
@) -0 fodr-a
Cshares Prahed s TTI0NG. ey
fTranglomed Brtes  QTotel i Teanshen o
s il
Jal e "

il |+ g e | B mepores |
[ Eeere I F
b Starting sremarie Dackmand File Server

Hetwark i succesdully redeedted

048 uxredhuly redrected Lo vk s
B Mostrue sucosstuly critchad to PR
Wi Hostname soooessh by seibched ko F50i e i
W ok o500} i chcerrnctad.

Stopping soenaria File Server

]

Brprrring thavm

Stasting switchowes procedures...

B

To initiate switchback:

1.

Ensure that both master and replica servers are available on the network
and the WANSync service (XOsoft Engine) is running.

From WANSync Manager, choose the desired scenario.

Skip this step if the backward scenario is already running. If the backward
scenario is not running, select Run to start the scenario: WANSyncHA
detects that a switchover has occurred and prompts you that it is running a
backward scenario.

If resynchronization was required wait for it to complete. You will receive the
following message in the Event window: All modifications during
synchronization are replicated.

Click on the Perform Switchover button or select Perform Switchover from
the Tools menu and then click OK on the Perform Switchover confirmation
window.
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After switchback is completed, you can again run the scenario in its original
(forward) state. In order to avoid resynchronization after a successful
switchover, you can opt to use the Run Reverse Replication Scenario
Automatically option (see Automatic Switchover and Reverse Replication).
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Appendix A: WANSyncHA Tips

This chapter provides you with helpful information concerning the application.

Spool Settings

The WANSyncHA spool is a folder on disk where data to be replicated is backed
up (i.e., spooled) if bandwidth is not sufficient to transfer the amount of changes
in real-time. Data can spool due to temporary network disconnections, network
congestion, or simply because the network bandwidth is not sufficient to transfer
the amount of data changing over on the server.

In addition to storing changes waiting on available bandwidth, spool space is also
used as part of the normal synchronization process. Thus, some spool build up
during synchronization is normal.

Place the WANSyncHA spool folder on a drive with relatively low use such as a
dedicated volume or boot/system volume. Do not place the spool folder on a
volume containing frequently accessed system (OS), user, or application data.
Examples include volumes containing databases, shared files, or the system
pagefile. By default, the spool folder is located in the tmp folder under the
WANSyncHA installation directory. The spool parameters, located in the
properties tab (on both master and replica) or set with the New Scenario Wizard,
determines how much disk space is available for the spool. In most cases the
default values are sufficient. However, if you choose to change this value, it
should be at least 10% of the total dataset size. For example, if you are
replicating 50GB of data on a server you should ensure that at least 5GB of space
is available for spool. Please note that this space is not pre-allocated.

Important! If you change the spool location, please remember to remove the
new path from file level antivirus scans: both scheduled and real time.
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Recover Active Server

Recover Active Server

In certain circumstances, it may be necessary to forcibly make the master or
replica server the active server without completing the data synchronization
process. For example, if switchover occurred but no data was changed on the
replica server. In this case you may even have newer data on the master server
making it undesirable to synchronize data from the replica to the master server.
WANSyncHA allows for this option through a process called Recover Active
Server. To use this option, ensure that the scenario is stopped, and select
Recover Active Server from the Tools menu.

Important! While this option is the right choice in many situations, use it with
caution. If used improperly data loss can occur. Normally WANSyncHA will not
allow switchover from one host to another until all data is synchronized. It is
designed this way so users are not redirected to an out of date data set that then
overwrites what may be a more current data set. When using Recover Active
Server, WANSyncHA is forcing users to one server or the other with no regard
as to which server has the correct data set. Thus, as an administrator, you must
manually ensure that the server you are making active has the most up to date
data set.

Recover Active Server is not available if you are using the Switch Computer
Name redirection method.

@) x0soft WANSync Manager 4.0.61

Scenario  Edit  Ewenks Eiewll.:u:.ls Help -

| 2@ p|Ee| ban @
i ] Q@' Synchronize
Scenario name e 2 Restore Data

;% Frample Scenario

Reports L4

E@ Perform Switchaver
Eﬂ Suspend Is glive theck

Recoy B

Skatistics L4

[l Suspend Replication
@ Feplica Inteqrit: Testing

@ stark/stop Logging
Gek Log File

v=| Set Rewind Bookmark:

|7 Pap-up on Incoming Event
ﬁ Launch Remote Inskaller
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(@0x0solt WANSYn: Manager 4.0.61

|Sconario. Edt Events Vew Inok Heb- .
|l 28 | D | o 8 5 G 00 2| B 2

‘;. Recover Active Server L xf

Current host srv0l is active. host sruwl2 iz stand-
To make ster or Replica active, press the corresponding button below

| Property | vahoe | Property. | vaiue
1[4 Mast tm:u"“ srvil =1 [1] replica (stand-by) srv2
B #1] System Information
Ja Metweork traffic dection [] xsoft Engine LogOn acc...
L[x] ons Foinks to Master (3 Network Configuration
i8] System Information

{3 xosoft Engine Logon acc...
D a Network Configuration

| 4 | )
Make MasterActive | Make Bepbcadetive | [ Cancel ||
E

Select either Make Master Active or Make Replica Active depending onto which
server you want to force the active role.

Important! If a legitimate switchover in a disaster situation occurs and users
are redirected to the replica server for any period of time, it is important to
replicate all changes on the replica back to the master before making the master
server active. Using Recover Active Server in such a situation results in loss of
data.
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Read Only Web GUI

Read Only Web GUI

The primary WANSync Manager may only be used by one Administrator at a
time. Opening the GUI locks it for the current user making simultaneous use
impossible. This is required to prevent conflicts. To allow simultaneous

monitoring by any number of administrators WANSyncHA also offers a read only
Web GUI.

To access the web GUI:

Open your browser to http://masterservername:25000.

2. Enter a user account and password with administrative permissions on the
master server.

OBack LD [ |_'| |:] | ) Saarch -';:?-Faw:urites {'ft | ¥ I
Address I% http:/fsre01: 25000

-

Password Fequired

User name: I €7 cxampleladministrator ;I

Password: quu-u|

[ Remember my password

Ok, I Cancel
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http://masterservername:25000
http://masterservername:25000

Read Only Web GUI

Important! There is no need to refresh the browser; the GUI refreshes
automatically. You can monitor all parameters, statistics, and events from

this window.

ANSyne Manitor - Microsoft 1
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B Example Scenari EEEE“"% a:m :;M;':
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Started by:
Wersion: 4,061
Spool space:
e T of threshold |
= oo |
Online file changes per rook directory:
[ | Removed | Benamed 1
CifTock [tetes o 1o lo |
Trasaderred bytes o Replicas:
| | Sem | Currewk Fibe o -
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& il -5 s =
Evnts |
Hot [Tme | Typn =
SOV 1180 SAnc Bk S| A iciicgfior i chvost st parkod S v st
2 | 10 Synchronization
2 (1535 | b | sty ok s st
srvliz | 12098 | Informationsl | Starked syncheonization of deeckory Ci[Tooks ...
sl IT%_h ) | Sgrificent. | Sharted synchenonization: method e Snchronization” {ignone fies with the same size and modfication tme) ..
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syl | 121909 | Sgnficant | Starting scanai Exangle Scensria
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Appendix B: Automatic Switchover and
Reverse Replication

This chapter describes the automatic (triggered) switchover and automatic
reverse replication processes.

Automatic Switchover

Triggered (automatic) switchover is in all ways identical to manual switchover
performed by the administrator. Automatic switchover is triggered by a resource
failure on the master server rather than by an administrator manually initiating
the switchover by clicking the Perform Switchover button. Server ping response,
application service status, and database connectivity are monitored. The timeout
parameters are configurable and are more extensively covered in the WANSync
User Guide.

Automatic Reverse Replication

When this feature is off, to start reverse replication after a switchover has
occurred, click the Run button. The benefit to this feature is, if both the master
and replica servers were online and connected during switchover,
resynchronization in the reverse direction is not required. Resynchronization
involves comparing the data on the master and replica servers to determine
which changes to transfer before real-time replication starts; this can take some
time. If automatic reverse replication is turned on, and both servers were online
during switchover, replication is reversed without the need for
resynchronization. This is the one situation in which resynchronization is not
required.
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Best Practice

Best Practice

It's not recommended to use automatic reverse replication with IIS scenarios:
WANSync is unable to validate that your replica data is good before overwriting
the data on the master server (after switchover). In database scenarios (SQL,
Exchange, etc.) this option is safe because WANSync validates that the replica
databases are good before overwriting data on the master server. With IIS
scenarios no such protection exists and as such this option is not recommended.
Use only if you fully understand the possible implications.
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Appendix C: Move IP Redirection

This section describes how to add Move IP redirection to a high availability
scenario. Use this method only when both servers are on the same IP subnet.

Move IP on the Master Server

Before configuring the scenario, add an additional IP address to the master host,
(which is denoted as WS-IP in the following steps). If you have already
configured your scenario go ahead and add this IP address; special steps for this
situation are listed below. This new IP address is used for WANSync internal
communication and replication. This is necessary since the current production IP
address is not available on the master after switchover -- it switches to the
replica server.
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Move IP on the WANSync Manager

Note that in the following screen shot, the WS-IP IP address is 192.168.220.23
and the current production server IP address is 192.268.220.111.

-i. Local Area Connection Properties

Internet Protocol (TCP/IP) Properties

74 dvanced TOP/IP Settings

ve 1P Settings |ons | wins | options |

th
[% fo [P addresses
' IP address | Subnet mask
192.168.220.111 255.255.255.0
st [N e | Rows |
[ octekavewe pTYTTS— 2
192.163.220.; [P address: | 152 . 168 . 220 . 23
Subrist mask: | 255 .255 .255 . O
il | Add I Cancel I

¥ Automatic metric

= Inkertate metic |

Move IP on the WANSync Manager

This subsection details Move IP redirection on the WANSync Manager.
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Move IP on the WANSync Manager

For New Scenarios

To implement Move IP with new scenarios:

During the initial run of the Wizard, enter the WS-IP and replica IP addresses
instead of the server names.

: New Scenario : F x|

Steps Master and Replica hosts

‘( W Enter the hostname or IP address for both the kMaster and Replica hosts. Master refers to the production server and
elcome . A : ot
. Replica refers ta the standby server. [f the scenarnio will invalve mare than one replica. press the "Finish"' button to

hf” Scenario Type continue configuration manually.
kf’ Scenario Setup

b Hosts

Maszter Configuration

Replica Configuration
Foot Directories & Scenaria name IMS 1S Server

WS4P
Scenario Froperties /
Swikchaver Properties E5  Master Hostrame/IP |192.158.22|:I.23 |

Agzzured Recovery

Scenario Verification

Run Scenario

O Replica Hostname/AP |192.168.220.24 \ =

Replica Server P
Address

Scenario Wizard

< Back Finish Cancel

4
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Move IP on the WANSync Manager

For Existing Scenarios

To implement move IP with existing scenarios:

1. If the Hosts pane is in Graphical View switch to Replication Tree view by
clicking the left button in the top right corner of the pane.

Hosts - iGraphical Yiew J E=8 ]
baster /Eeglica

Hosts - Replication Tree = M

Hosks I

iﬁ’éwz.laa.zzn.za
192,168.220,24

2. Right click on the master host name and choose Rename. Then enter the
WS-IP address.

3. Select the Switchover tab and then select the replica server as the
switchover host.

4. Set the Move IP option to On. Ensure that the IP address under Move IP,
IP/Mask matches the production server IP address: this is the IP address
that will switch over. If you are moving more than one IP address you can
add multiple production IP addresses by selecting Click here to add new

IP/Mask.
Hosts - Replication Tree r?-ﬁ
Hosts Property I Walue
7 Liioz1es.200.23 =11 switchover
192.168.220.24 ] E| Switchover host name 192.168.220.24
— Perform switchover automatically OFf
—|i2| Run reverse replication scenario after switchowver OFf
=&} Hosts
— Master Fully qualified name SR04
Replica fully qualified name SRMOS
[—} Metwork Traffic Redirection
Mowve IP on
— IPTask. 192,168,220,111 , 255,255.255.0
Add IP/Mask, .. Click. here to add new IP/Mask,
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Cluster Move IP

Cluster Move IP

Using Move IP redirection with a clustered master (MSCS with shared storage)
requires you to add an additional IP resource to the master File Server resource
group. This section describes Move IP redirection from a master cluster to a
single server replica.

Note: If both master and replica are clusters there are special configuration
issues involved in the Move IP redirection process that are not detailed in this
guide. For a cluster-cluster scenario, use Redirect DNS or contact technical
support to receive detailed instructions and guidance.

On the Master Cluster

To use cluster move IP on the master cluster:

Open the Cluster Administrator.

2. In the Master Cluster IIS Resource Group, create a new IP resource and
name it WS-IP.

3. Bring this resource online and verify it is visible from the replica via the ping
command. This new IP address is used for WANSyncHA internal
communication and replication. This is necessary since the current
production IP address is not available on the master cluster after switchover
-- it switches to the replica server.

On the WANSync Manager

This subsection details Cluster Move IP redirection on the WANSync Manager.
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Cluster Move IP

For New Scenarios

To implement cluster Move IP with new scenarios:

During the initial run of the Wizard, enter the WS-IP and replica IP addresses
instead of the cluster virtual server names.

-ﬁ} New Scenario

Steps

" Welcome

i Scenario Type

i’ Scenario Setup

[ Hosts
M aster Configuration
Replica Configuration
Fioot Directories
Scenario Properties
Switchover Properties
Azzured Recovery

Scenario Yerification

Run Scenario

Scenario Wizard

Master and Replica hosts

Enter the hoztnarme or [P address for bath the Master and Replica hosts, Master refers to the production server and
Replica refers to the standby server. [F the scenario will invalve mare than one replica. press the "Finizh" button to
continue configuration manually,

&5 Soenario name MS 115 Server WSJP

& ReplicaHostnameAP |192.168.220.24 \ |

Replica Server IP
Address

192.168.220.23

L‘ﬂ tdaster Hostname/IP

¢ Back Finish Cancel
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Cluster Move IP

For Existing Scenarios
To implement cluster move IP with existing scenarios:

1. If the Hosts pane is in Graphical View switch to Replication Tree view by
clicking the left button in the top right corner of the pane.

Hasts - Graphical Yiew P 4 = [H
hastar ""Eeglica

Hosts - Replication Tres = H

Hosts I

?E.ﬁélgz.ma.zzn.ﬂ
LM 192.168.220.24

2. Right click on the master host name and choose Rename. Then enter the
WS-IP address.

3. Select the Switchover tab and then select the replica server as the
switchover host.

4. Set the Move IP option to On. Ensure that the IP address under Move IP,
IP/Mask matches the production server IP address: this is the IP address
that will switch over. If you are moving more than one IP address you can
add multiple production IP addresses by selecting Click here to add new

IP/Mask.
Hosts - Replication Tree Ei
Hosts Propert: | Walue
7 Loz e znzs £1E) Switchover
L@' 192.168.220,24 = El Switchover host name 192.168.220.24
- [i=] Perfarm switchover automatically OFf
-- Run reverse replication scenario after swikchover CIff
=HEl Hosts
— Master Fully qualified narme SR04
Replica Fully qualified name SRVOS
[—} MNetwork Traffic Redirection
Mave IP an
I: PiMask 192.168.220.111 , 255.255.255.0
Add IPfMask. ., Click here to add new IPMask,
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Cluster Move IP

46  WANSyncHA IIS Server Operations Guide



Appendix D: Switch Computer Name
Redirection

Automatic

Manual

This chapter describes the method of redirection in which you switch the
computer name.

When possible during switchover, WANSyncHA gracefully renames the master
host to masterhostname-X0O and assigns its original name to the replica server.
This step prevents name conflicts since the master's name is now assigned to
the replica server. In this graceful case, if automatic reverse replication is set to
on, WANSync starts the backward scenario automatically. If automatic reverse
replication is set to off, run the scenario again manually by selecting the Run
button or choosing Run from the Tools menu. Once the backward scenario has
run and synchronization is complete you can click the Perform Switchover button
to switch back.

If the master server was offline or otherwise unavailable during switchover
WANSyncHA may not be able to rename the master to masterhostname-X0O. In
this case, it is necessary to perform the following steps manually before bringing
the master back onto the network and starting the backward scenario:

1. Unplug the master server from the network and log on as a local
Administrator.

Plug the master back into the network.

Rename the master server to masterhostname-XO. For example, name the
master server SRV-XO and move it to a workgroup.

4. Join the master server back to the domain with the temporary name
masterhostname-XO.
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Manual

5. If automatic reverse replication is set to on, WANSync starts the backward
scenario automatically; if it is set to off or the scenario was stopped, run the
scenario again manually by selecting the Run button or choosing Run from
the Tools menu. Once synchronization from replica to master is complete you
can click the Perform Switchover button to switch back.
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Appendix E: Replication in a Workgroup
Environment

WanSyncHA can replicate IIS data between two servers in a workgroup
environment. Since servers in a workgroup do not have access to a common
security database, it is necessary to create identical service accounts locally on
both servers and assign them identical passwords. If anonymous access is used,
configure all websites running on both servers to use the same
username/password combination for anonymous access. Failure to do this
results in an authentication window when trying to access web sites on the
replica server.

Configure Service Accounts

To configure service accounts:

Create identical user accounts on both servers.
Assign identical passwords to both accounts.

Configure this as the account used for anonymous access in the properties
of each web site for which anonymous access is enabled.

4. If you want to use the default IUSR_<computername> account on both
servers for anonymous access, ensure that you assign identical passwords
to both accounts, and uncheck the “Allow IIS to control password” selection
in the Properties > Directory Security > Authentication Methods section of
each web site for which anonymous access is enabled.

Important! If the IIS scenario is configured to replicate ACLs, a view of the

security properties of the folder(s) containing web site content on the replica
shows an unresolved SID - this is by design and can be ignored.

Additional Resources

The following Microsoft knowledge base articles discuss how to configure web
site authentication:
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Additional Resources

m  For IIS 5.0: How To Configure IIS 5.0 Web Site Authentication in Windows
2000 - http://support.microsoft.com/kb/310344

m  For IIS 6.0: How To Configure IIS Web Site Authentication in Windows
Server 2003 - http://support.microsoft.com/kb/324274
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